


ถงึแมในปจจบุนัการแตงภาพจะกลายเปนเรื่องงาย จากการเขามาของแอพพลเิคชนั

ที่ทาํใหทกุอยางสาํเรจ็ไดในไมกี่จึ้ก (จึ้ก คอื หนวยของการจิ้มหนาจอสมารทโฟน)

แลวทาํไมพวกเรายงัพยายามหนามนึที่จะทาํหนงัสอืสอนรทีชัภาพดวย Photoshop 

ออกมากนัอกีนะ

ถามกลบังายๆ เลยครบั “แอพพลเิคชนัพวกนั้นมนัตอบทกุจนิตนาการไดหรอืเปลา” 

ใชครบั ไมได

เมื่อเรยีนจบมาหรอืเมื่อตองทาํงาน คงไมมใีครใชแอพฯ ทาํงานสาํหรบัสงงานให

ลูกคาหรอก จรงิไหมครบั

แลวจะเอาอะไรฝก Photoshop ดนีะ

นั่นละครบัที่มาของหนงัสอืเลมนี้ ฝกรทีชั ตดัตอ ใชเครื่องมอืตางๆ ของ Photoshop 

สรางภาพที่เหนอืจนิตนาการขึ้นมา สิ่งที่จะไดแนๆ กค็อื จะมหศัจรรยใจไปกบัเทคนคิการ

ใชเครื่องมอื คาํสั่งซึ่งสิ่งตางๆ เหลานี้จะเปนเทคนคิตดิตวัไปใชงานในอนาคต และตอบ

โจทยจนิตนาการของเราเอง นอกจากนั้นยงัทาํใหเราเกดิความคุนเคยกบัการประยกุตใช

งาน ซึ่งจะทาํใหจนิตนาการครั้งตอไป กวาง และไรขอบเขตมากยิ่งขึ้น

ขอใหสนกุกบัการรทีชัและการประยกุตใชเครื่องมอืจากหนงัสอืเลมนี้

ขอบคณุครบั

ปยะบตุร สทุธดิารา

 สงิหาคม 2559

Editorial



หนงัสอืเลมนี้ใชระยะเวลาในขั้นตอนการเรยีบเรยีงเปนระยะเวลานาน จวนเจยีนจะ

ลมเหลวดวยปญหาตางๆ มากมาย แตตองขอขอบคณุ บ.ก. ปยะบตุร สทุธดิารา ที่ยงั

เชื่อมั่น ใหกาํลงัใจ จนสามารถเอาชนะอปุสรรคตางๆ และสามารถจดัทาํหนงัสอืเลมนี้ได

เสรจ็สมบูรณ ขอขอบคณุกองบรรณาธกิาร ฝายผลติทกุทานที่ใหความอนเุคราะห และ

ชวยเหลอืเปนอยางด ี

ขอขอบคณุจากใจอกีครั้ง

Thanks



Author

เกยีรตพิงษ บญุจติร

สงิหาคม 2559

การรีทัชภาพใหสวยงามอลังการอาจเปนเรื่องที่ใครหลายคนคิดวาไกลตัวเกินไป 

ใช Photoshop ไมเกงคงทาํไมไดแนนอน 

ความคดินี้อาจไมถูกตองทั้งหมด เพราะความจรงิแลวการรทีชัภาพนั้น 

“เครื่องมอืและคาํสั่งอาจไมสาํคญัเทาจินตนาการ”

หนังสือเลมนี้จะพาผูอานไปทําความรูจักกับเครื่องมือ และคําสั่งที่มหัศจรรยของ 

Photoshop เพียงไมกี่อยางก็สามารถพลิกแพลงการใชงานเพื่อสรางเอฟเฟกตใหภาพ

ออกมาสวยงามอลงัการได

หนงัสอืเลมนี้จงึเหมาะกบัทกุคนที่มคีวามหลงใหลการรทีชัภาพ และตองการพฒันา

ฝมอืในการสรางสรรคผลงานใหออกมาสมบูรณที่สดุ

สดุทายนี้ผูเขยีนหวงัไวเปนอยางยิ่งวา หนงัสอืเลมนี้จะมปีระโยชนกบัผูอานไมมาก

กน็อย หากมขีอผดิพลาดประการใด ตองขออภยัไว ณ ที่นี้ดวย
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Essential Photoshop Skills
Intro

Photoshop มีเครื่องมือและคําสั่งการทํางานมากมาย แต่ในการใช�งานจริงต่อให้งานมีความซับซ�อนแค่ไหน 
แต่ก็มีเครื่องมือไม่กี่ตัวหรือไม่ก่ีคําสั่งเท่านั�นที่เราต้องใช�อยู่เสมอ ซ่ึงหนังสือเล่มนี�จะสอนให้ผู้อ่านได้สร้างสรรค์ผล
งานการรีทัชภาพให้ออกมาสวยงามอลังการด้วยเครื่องมือและคําสั่งไม่กี่อย่าง

และเนื�อหาในบทนี�ผู้เขียนไดร้วบรวมเครื่องมอืและคาํสั่งที่จาํเป�นตอ่การใช�งาน รวมไปถงึเทคนคิการใช�งานตา่งๆ
เพื่อให้การทํางานสะดวกมากยิ่งขึ�น ซ่ึงศึกษาได้จากหัวข้อต่างๆ ต่อไปนี�

Essential Photoshop 
Skills

Intro

2



Photoshop
Creative Retouch

การรีทัชเพื่อลบจุดบกพรองเบื้องตน
สิ่งแรกที่ต้องเรียนรู้สําหรับการทํางานใน Photoshop ไม่ว่าจะเป�นเวอร์ชันใดก็ตามคือ วิธีรีทัชเพื่อลบหรือแก้ไขจุด

บกพร่องของภาพ และคงไม่มีเครื่องมือใดที่ทรงประสิทธิภาพและได้รับความนิยมเท่ากับเครื่องมือ  (Clone Stamp Tool) 
และ  (Spot Healing Brush Tool) ซ่ึงเราจะมาทําความรู้จักกับเครื่องมือทั�ง 2 นี�อย่างละเอียดกัน

รีทัชแกไขจุดบกพรองดวยเครื่องมือ Clone Stamp Tool
 (Clone Stamp Tool) เป�นเครื่องมือดั�งเดิมของ Photoshop ที่มีให้ใช�งานในทุกเวอร์ชัน จุดเด่นของเครื่องมือนี�

คือสามารถนําพื�นท่ีจุดที่ต้องการมาแปะทับบริเวณท่ีมีปัญหาได้ ซ่ึงการใช�งานให้ได้ผลลัพธ์ที่ดีนั�นจะต้องปรับค่าของ
เครื่องมือให้เหมาะสม ซ่ึงค่าการปรับแต่งที่สําคัญของเครื่องมือ  (Clone Stamp Tool) มีดังนี�

กําหนดขนาดและ
ความฟุงของเครื่องมือ

กําหนดโหมดการผสมสีของพื้นที่ตนฉบับ 
และจุดที่ตองการแปะทับ

กําหนดใหสีเขมขึ้นเมื่อแดรกเมาส
ที่จุดเดิมซ้ําๆ

กําหนดน้ําหนักของเครื่องมือ
ในการใชงานแตละครั้ง

เลือกออปชันการรีทัช
เมื่อทํางานหลายเลเยอร

กําหนดความเขมตามน้ําหนัก
การกดเมื่อใชกับ Tablet

สาํหรบัแนวทางการใช�งานเครื่องมอื  (Clone Stamp Tool) นั�น เรา
จะต้องวิเคราะห์ความบกพร่องของภาพเสียก่อนว่ามีจุดบกพร่องบริเวณใด
และจะสามารถนําพื�นที่ใดมาแปะทับได้บ้างดังภาพตัวอย่าง หากต้องการ
รีทัชเสาไฟและสายไฟด้านข้างออกจะต้องนําท้องฟ�าและพื�นท่ีใกล้เคียงมา
แปะทับนั่นเอง

เมื่อวิเคราะห์เบื�องต้นได้แล้วก็เข้าสู่ขั�นตอนการทํางาน โดยเราจะเริ่มต้น
โดยปรับค่าเครื่องมือ  (Clone Stamp Tool) ก่อน ซ่ึงหัวใจสําคัญอยู่ที่

ขนาดและค่า Hardness 

ตัวอยางการกําหนดคาใหเครื่องมือ  (Clone 
Stamp Tool) โดยกําหนดคา Hardness เปน 0% 
เพื่อใหเครื่องมือมีขอบแบบฟุง ซึ่งจะชวยใหการรีทัชมี
ความกลมกลืนมากขึ้น

สําหรับค่า Hardness มักกําหนดเป�น 
0% เพื่อให้เครื่องมือมีขอบฟุ้ง ซ่ึงจะช่วยให้
ได้ผลลัพธ์ท่ีกลมกลืนกว่า (การกําหนดค่า 
Hardness สูงๆ มักใช�ในกรณีที่รีทัชภาพที่มี
รายละเอียดเลก็ๆ และมพีื�นท่ีไมก่วา้งมากนกั) 

3



Essential Photoshop Skills
Intro

สําหรับขนาดของเครื่องมือ  (Clone Stamp Tool) สามารถกําหนดได้ง่ายๆ โดยกดปุ่ม  เมื่อต้องการลดขนาด 
หรือกดปุ่ม  เพื่อเพิ่มขนาดเครื่องมือ

อีกค่าหนึ่งที่สําคัญ ได้แก่ ค่า 
Opacity หรือนํ�าหนักของเครื่องมือ 
การกาํหนดค่านั�นใหพ้จิารณาจากพื�นท่ี
การทํางาน หากมีรายละเอียดไม่ชัดเจน 
หรือเป�นพื�นที่โล่งๆ เช่น ท้องฟ�า ก็ควร
ลดค่า Opacity ให้ตํ่ากว่า 50% แต่
หากภาพมีรายละเอียดคมชัด ขอบเขต
ชัดเจนกค็วรเพิ่มคา่ Opacity ใหส้งูเพื่อ
ให้การรีทัชออกมาคมชัดเหมือนภาพ
ต้นฉบับนั่นเอง

เมื่ อกํ าหนดค่าให้ เค ร่ืองมือ
เรียบร้อยแล้ว ก็เข้าสู่การทํางานซ่ึง
จะมีหลักการอยู่ว่า เราจะต้องกดปุ่ม  

 แล้วใช�เครื่องมือ  (Clone 
Stamp Tool) คลิกไปยังพื�นที่ต้นฉบับ
เพื่อก็อปปี� เสียก่อน 

ตัวอยางการกําหนดคา Opacity โดยลดลงเหลือ 50% เนื่องจากบริเวณที่มีปญหามีรายละเอียด
ไมมากนัก หากใชคา Opacity สูงไปจะทําใหสีสันไมสมํ่าเสมอ

เมื่อเลื่อนเมาส์ไปจุดที่มีปัญหา 
ซ่ึงจะปรากฏพื�นที่ที่ เราก็อปปี� ไว้จาก
ขั�นตอนที่ผ่านมาด้วย ก่อนท่ีจะคลิก
ลงไปให้พิจารณาก่อนว่ามีสีสันใกล้
เคียงกับจุดที่มีปัญหาหรือไม่ 

หากตรวจสอบแล้วมีสีสันใกล้
เคียงกันก็ให้คลิกเพื่อแปะทับลงไป ซ่ึง
เราสามารถคลิกซํ�าๆ 2-3 ครั�งจนกว่า
จุดที่ เป�นปัญหาจะถูกลบไปดังภาพ
ตัวอย่าง 

เราสามารถแดรกเมาส์ไปยังจุด
อื่นๆ ของภาพเพื่อแก้ไขจุดที่บกพร่อง 
แต่หากพบว่าพื�นที่ต้นฉบับและจุดที่

เป�นปัญหามีสีสันของภาพแตกต่างกัน
จนเกินไปก็ให้กดปุ่ม  แล้วใช�
เครื่องมือ  (Clone Stamp Tool) 
คลิกไปยังพื�นที่ ใหม่ แล้วจึงนําไป
เกลี่ยทับจุดที่เป�นปัญหา
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แกไขจุดบกพรองเล็กๆ ดวยเครื่องมือ   Spot Healing Brush Tool
 (Spot Healing Brush Tool) เป�นเครื่องมือที่สามารถรีทัชภาพเพื่อแก้ไขจุดบกพร่องได้เช่นกัน โดยจุดเด่นจะอยู่ที่

เครื่องมอืตวันี�จะนาํพื�นผิวบรเิวณรอบข้างมาเกลี่ยทบัจุดที่เป�นปัญหา แตอ่าจจะไมเ่หมาะกบัการรทีชัพื�นที่ขนาดใหญ ่หรอืพื�นที่

ที่มีรายละเอียด แสง สีแตกต่างกันมากเกินไป ซ่ึงก่อนการใช�งานจะต้องกําหนดค่าของเครื่องมือให้เหมาะสม ดังนี�

กําหนดขนาดของ
เครื่องมือ

กําหนดใหนําพื้นที่รอบ
ขางมาเกลี่ยเปนสีใหม

เลือกโหมดการผสานสีของ
เครื่องมือ

กําหนดใหนําพื้นผิว
มาสรางเปน Pattern

กําหนดใหเติมพื้นผิวแบบคํานวณ
จากจุดรอบดาน

ใหนําจุดที่แกไขมาเก็บไวบน
เลเยอรใหม

เมื่อต้องรีทัชแก้ไขจุดที่มีรายละเอียดชัดเจน ก็ให้ลด
ขนาดเครื่องมือลง พร้อมเพิ่มค่า Opacity ให้สูงขึ�น หรือ
อาจจะเพิ่มค่า Hardness ขึ�นอีกเพื่อให้ขอบเขตคมชัดเหมือน
เดิม  เมื่อเรียบร้อยแล้วก็จะได้ผลลัพธ์ดังภาพ

อย่างไรก็ตามมีอีก 1 สิ่งที่ต้องให้ความสําคัญคือ 
การใช�เครื่องมือ  (Clone Stamp Tool) รีทัชภาพนั�น
จะเป�นการแก้ไขภาพโดยตรง หากเกิดความผิดพลาดอาจ
แกไ้ขยากขึ�น เราสามารถป�องกันปัญหานี�ไดโ้ดยเลอืกออปชัน 
Sample All Layers บนออปชันบาร์

หลังจากนั�นสร้างเลเยอร์ว่างๆ ไว้ด้านบนสุด เมื่อใช�
งานเครื่องมือ  (Clone Stamp Tool) รีทัชภาพก็จะ
เป�นการคัดลอกพื�นผิวมาเก็บไว้บนเลเยอร์ว่างนี� ทําให้ภาพ
ต้นฉบับไม่เสียหายจากการทํางานนั่นเอง
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การใช�งานเครื่องมือ  (Spot Healing Brush Tool) ไม่มีอะไรซับซ�อนเหมือนเครื่องมือ  (Clone Stamp Tool) 
เพียงแค่สร้างเลเยอร์ว่างๆ ไว้ด้านบน พร้อมกับเลือกออปชันของเครื่องมือแบบ Content-Aware และคลิกเลือก Sample All 
Layers เพื่อป�องกันความผิดพลาดที่อาจเกิดขึ�นกับภาพต้นฉบับ 

เมื่อกําหนดค่าเรียบร้อยแล้วก็
ให้ใช�เครื่องมือคลิก หรือแดรกเมาส์
ไปยังจุดที่ต้องการแก้ไข เพียงเท่านี�
จุดบกพร่องที่ เราไม่ต้องการก็จะถูก
เกลี่ยทับดว้ยพื�นท่ีรอบขา้งโดยอัตโนมติั

ถึงแม้ว่าเครื่องมือ  (Spot 
Healing Brush Tool) จะใช�งานงา่ย แต่
ก็มีข้อจํากัดเม่ือต้องทํางานกับบริเวณ
ที่ มีความแตกต่างของสี หรือความ
สว่างมากๆ อาจให้ผลลัพธ์ท่ีไม่ดีนัก 
ซ่ึงอาจต้องใช�เครื่องมือ  (Clone 
Stamp Tool) เข้ามาช่วยด้วย

ขอจํากัดของเครื่องมือ  (Spot Healing Brush Tool) เมื่อรีทัชบริเวณที่มีความแตกตาง
มากๆ (ภาพซาย) ซึ่งจะเห็นวาภาพเกิดความเสียหาย ดังนั้น หากตองการรีทัชบริเวณที่รายละเอียด
มากๆ แบบนี้ควรใชเครื่องมือ  (Clone Stamp Tool) จะใหผลลัพธที่ดีกวา (ภาพขวา)
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สารพัดเทคนิคตัดวัตถุออกจากฉากหลัง
การตัดต่อภาพให้ออกมาสมจริงนั�น หัวใจสําคัญส่วนหนึ่งจะอยู่ที่การสร้าง Selection เพื่อตัดภาพออกจากฉากหลัง 

แลว้นาํไปใช�งานรว่มกบัภาพอ่ืนๆ ซ่ึงการ Selection นั�นทําไดห้ลากหลายวธิ ีมเีครื่องมอืเป�นสบิแบบที่ใช�ในการสรา้ง Selection 
ได้ แต่ในหัวข้อนี�เราจะมาทําความรู้จักวิธีวิเคราะห์รูปแบบของภาพ และการเลือกเครื่องมือให้เหมาะสมในการทํางาน ดังนี� 

ตัดฉากหลังอยางงายดวยเครื่องมือ Magic Eraser Tool
 (Magic Eraser Tool) เป�นเครื่องมือที่ใช�ตัดฉากหลังให้ภาพแบบง่ายๆ แต่จะเหมาะกับภาพที่มีฉากหลังเป�นสีพื�น 

เช่น ท้องฟ�าที่ไม่มีรายละเอียดมากนัก แต่ควรมีสีสันแตกต่างจากวัตถุหลักในภาพพอสมควร เนื่องจากเครื่องมือจะวิเคราะห์ 
และลบขอบเขตที่มีสีสันใกล้เคียงกันออกไปด้วย ซ่ึงการใช�งานเครื่องมือให้ได้ผลลัพธ์ที่เหมาะสม  (Magic Eraser Tool) 
ควรปรับค่าต่างๆ ต่อไปนี�

01 หลงัจากที่เลอืกเครื่องมอื  (Magic Eraser Tool)

แลว คาแรกที่ตองปรับคา Tolerance ซึ่งเปน

คาความตอเนื่องของสี หากกําหนดคาสูงจะทําใหเมื่อคลิก

เครื่องมือลงไปแลวสีที่แตกตางกันจะถูกลบออกไปดวย แต

หากกําหนดคาตํ่าก็จะเปนการลบเฉพาะสีที่ใกลเคียงกัน

เทานั้น

คลกิเลอืก Anti-alias คอื การปรบัลกัษณะเสนขอบของ

วัตถุไมใหเปนรอยหยัก และคลิกเลือก Contiguous หาก

ตองการลบเฉพาะขอบเขตที่ตดิกนัเทานั้น

02 หลังจากที่กําหนดคาใหเครื่องมือเรียบรอยแลว 

เมื่อคลิกไปบนทองฟา ซึ่งเปนสีพื้นก็จะพบวา

ฉากหลังนั้นถูกลบทิ้ง และสามารถก็อปปภาพเพื่อนําไป

ใชงานไดทนัท ี
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ตัดฉากหลังโดยอางอิงจากสีดวยคําสั่ง Color Range
คําสั่ง Color Range เป�นคําสั่งที่ใช�สําหรับเลือกขอบเขตในการทํางานโดยอ้างอิงจากโทนสีและความสว่าง ซ่ึงภาพ

ที่เหมาะในการใช�งานด้วยคําสั่งนี�คือภาพที่มีฉากหลังเป�นสีพื�นเรียบๆ แต่เราจะสามารถควบคุมขอบเขตได้ยืดหยุ่นกว่าการใช�
เครื่องมือ  (Magic Eraser Tool) ซ่ึงการใช�งานคําสั่ง Color Range ทําได้ดังนี�

03 เลอืกเครื่องมอื  (Add to Sample) หลงัจากนั้น

คลกิไปบนจดุตางๆ จนฉากหลงัเปนสขีาวทั้งหมด 

เมื่อเรยีบรอยแลวปรบัคา Fuzziness เพื่อควบคมุขอบเขตให

อยูในพื้นที่ที่ตองการ

02 คลกิเมนู Select > Color Range เพื่อเปดคาํสั่ง 

หลงัจากนั้นใชเครื่องมอื  (Eyedropper Tool) 

คลิกไปบนฉากหลังที่ตองการตัดทิ้ง ผลที่ไดคือปรากฏพื้นสี

ขาวบนหนาตางคาํสั่ง แตยงัไมครอบคลมุพื้นที่ทั้งหมด

04 คลิกเลือก Invert เพื่อสลับดานใหฉากหลังเปน

สดีาํกอนแลวจงึคลกิปุม OK เพื่อทาํงานขั้นตอไป

01 ตวัอยางภาพถายที่มฉีากหลงัเปนสพีื้น แตเราจะ

เห็นวามีรายละเอียดของเสนผมอยูดวย หากใช

เครื่องมอื  (Magic Eraser Tool) อาจทาํใหรายละเอยีด

สวนนั้นเสยีหายไปดวย
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05 เมื่อกลบัเขาสูหนาจอการทาํงานปกต ิจะปรากฏ 

Selection รอบจดุที่เราตองการ ซึ่งสามารถกอ็ปป

เพื่อนาํไปใชงาน หรอืสามารถคลกิปมุ  (Add layer mask) 

เพื่อซอนขอบเขตของฉากหลงัไปกอนกไ็ด

สาํหรบัการสราง Layer Mask นั้นจะเปนวธิซีอนขอบเขต

ที่อยูนอก Selection แตสามารถเพิ่ม-ลด หรอืปรบัปรงุใหมได 

เนื่องจากไมไดเปนการตัดภาพทิ้งไปจริงๆ ซึ่งในการรีทัชตัด

ตอภาพ Layer Mask จะมีประโยชนมาก และเราจะมาทาํ

ความรูจกักบั Layer Mask ในหวัขอตอๆ ไป

ตัดภาพรายละเอียดมากๆ จากฉากหลังดวยเครื่องมือ Pen Tool
สําหรับภาพที่มีขอบเขตไม่ชัดเจน มีเหลี่ยมมุม รอยโค้งเว้ามากๆ และสีของฉากหลังไม่ใช่สีพื�น การเลือกทํางานกับพื�นที่

ลักษณะนี�จะต้องใช�งานเครื่องมือที่มีความสามารถในการกําหนดขอบเขตที่แม่นยํา 
ถึงแม้ว่าเครื่องมือ  (Pen Tool) มักถูกนําไปใช�สร้างเส้น Path แต่เราสามารถเปลี่ยนเส้น Path เหล่านั�นให้กลายเป�น

Selection ได้ ซ่ึงมีหลักการใช�งานดังนี�

01 จากภาพตวัอยางจะเหน็วา ภาพลกัษณะนี้จะไม

สามารถตัดฉากหลังออกไดดวยวิธีการที่ผานมา

การใชเครื่องมอื  (Pen Tool) ถอืวาเหมาะสมที่สดุ

02 หลงัจากที่เลอืกเครื่องมอื  (Pen Tool) แลว

ใหคลกิเลอืก Path บนออปชนับารเพื่อสรางเสน 

Path โดยไมตองเตมิสลีงในรูปทรงที่สรางขึ้น
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03 ใชเครื่องมอื  (Pen Tool) คลกิไปบรเิวณขอบ

ของภาพเพื่อสรางเสน Path สาํหรบับรเิวณที่เปน

สวนโคงของภาพใหใชวิธีคลิกแลวแดรกเมาส ซึ่งจะชวยให

เสน Path โคงรบักบัรูปทรงได

04 เมื่อสรางเสน Path คลุมรูปทรงจนรอบแลวให

คลิกขวาแลวเลือกคําสั่ง Make Selection แลว

กาํหนดคา Feather Radius ซึ่งคานี้จะเปนตวักาํหนดความ

ฟุงใหขอบของ Selection

แตเครื่องมอืนี้อาจมขีอจาํกดัหากตองสราง Selection ให

กับภาพที่มีสวนโคงเวามากๆ รวมไปถึงเราจะไมสามารถ

ปรบัปรงุขอบเขต Selection ในขณะที่ทาํงานได ซึ่งตางจาก

เครื่องมอื   (Pen Tool) ที่มคีวามยดืหยุนมากกวา

การใชเครื่องมือ  (Polygonnal Lasso Tool) สราง Selection 
จะเหมาะกับภาพที่ลักษณะเหลี่ยมๆ มากกวาภาพที่มีสวนโคงเวามากๆ

05 เมื่อเรียบรอยแลวเราก็สามารถตัดฉากหลังทิ้ง 

หรอืกอ็ปปภาพเพื่อนาํไปใชงานตอไดทนัที

นอกจากเครื่องมอื  (Pen Tool) แลวยงัมเีครื่องมอื

อื่นๆ ที่สามารถสราง Selection ในลกัษณะเดยีวกนัได เชน

เครื่องมอื  (Polygonnal Lasso Tool) 
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ตัดตอ เปลี่ยนฉากหลังภาพดวย   Layer Mask 
Layer Mask คือ วิธีการสร้าง Selection แบบหนึ่ง แต่เป�น Selection ที่สามารถปรับแต่งขอบเขตในภายหลังได้ Layer 

Mask จะมีลักษณะเหมือนกบัการเจาะหรอืตดัเลเยอรใ์หเ้ป�นรู โดยการเจาะหรอืตดันั�นจะทาํไดด้ว้ยการระบายสดีาํลงไปใน Layer 
Mask เพื่อซ่อนพื�นที่ และใช�สีขาวระบายลงไปเพื่อแสดงพื�นที่ตามปกติดังภาพตัวอย่าง

การสรา้ง Layer Mask ทาํไดห้ลาย
วิธี ไม่ว่าจะเป�นการสร้าง Selection 
ก่อน แล้วคลิกปุ่ม   (Add layer 
mask) ซ่ึงพื�นที่นอก Selection จะถูก
ซ่อนไปทันที แต่วิธีนี�จะเหมาะกับภาพ
ที่สามารถสร้าง Selection ง่ายๆ ได้

เมื่อเรานําภาพใหมมาวางไวใตเลเยอรที่สราง 
Layer Mask ไว ก็จะไดภาพที่ดูสวยงามขึ้น

ดวยวิธีงายๆ

ตัวอยางการนําภาพถายมาซอนกัน (ภาพซาย) แลวสราง Layer Mask ใหภาพในเลเยอรบน พรอมกับระบายสีดําเพื่อซอนบริเวณทองฟา จะเห็นวา
ขอบเขตถูกซอนไป (ภาพกลาง) และภาพผลลัพธเมื่อวางภาพซอนบนเลเยอร Background (ภาพขวา)

ตัวอยางภาพถายที่มีขอบเขตชัดเจนอยูแลว 
ซึ่งเราสามารถสราง Selection บริเวณ

ทองฟาไวกอนดวยคําสั่ง Color Range และ
เมื่อคลิกปุม  (Add layer mask) ก็จะ

เห็นวาทองฟาถูกซอนไปทันที
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อย่างไรก็ตามหากภาพที่นํามาใช�นั�นยากต่อการสร้าง Selection เน่ืองจากขอบเขตท่ีไม่ชัดเจน หรือเม่ือเราต้องการ
ผสานขอบเขตของแต่ละภาพที่นํามาตัดต่อกันมีความกลมกลืนกันนั�น เครื่องมือ  (Brush Tool) จะเข้ามามีบทบาทมากขึ�น

01 สําหรับขั้นตอนการสราง Layer Mask วิธีนี้จะ

เริ่มตนโดยนาํภาพที่ตองการตดัตอรวมกนัมาวาง

ซอนบนพาเนล Layers หลงัจากนั้นคลกิปุม  (Add layer 

mask) เพื่อสราง Layer Mask ใหเลเยอรที่ตองการปรบัแตง

เมื่อคลิกปุม  (Add layer mask) แลวจะปรากฏกรอบ
สีขาวดานหลัง ซึ่งกรอบสีขาวนี้คือพื้นที่การทํางานของเรา 

02 เมื่อไดกรอบ Layer Mask แลว ขั้นตอไปใหเลอืกเครื่องมอื  (Brush Tool) พรอมกบักาํหนดคา ซึ่งโดยสวนใหญ

แลว เรามกัจะใชหวัแปรงแบบขอบฟุงเพื่อใหภาพที่ตดัตอมคีวามนุมนวล สวนคา Opacity นั้นควรปรบัตามความ

เหมาะสม หลงัจากนั้นใหเลอืกสโีฟรกราวนเปนสดีาํ เพื่อใชในการซอนขอบเขตสวนที่เราไมตองการใหแสดง

03 เมื่อเราใชเครื่องมือ 

 (Brush Tool) คอื

ระบายสีดําลง ก็จะพบวาพื้นที่

สวนนั้นถูกซอนไปทันที ซึ่งจะ

สอดคลองกับกรอบสีขาวใน 

Layer Mask ที่จะปรากฏพื้นที่

สดีาํที่เราระบายลงไปดวย
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04 ในกรณทีี่เราระบายสดีาํเพลนิเกนิไป จนกนิพื้นที่

เขาไปในจุดสําคัญ ก็สามารถแกไขไดเพียงแค

เปลี่ยนสีโฟรกราวนนี้เปนสีขาวแลวระบายทับลงไป เทานี้ก็

จะสามารถเรยีกคนืพื้นที่นั้นกลบัมาได

05 เมื่อใชเครื่องมอื  (Brush Tool) ระบายสขีาว 

หรอืสดีาํลงไปใน Layer Mask เรยีบรอยแลวกจ็ะ

ไดผลลพัธที่เสรจ็สมบูรณดงัภาพ 

เทคนิคสําคัญของการใชเครื่องมือ  (Brush Tool)

ตดัตอภาพรวมกบั Layer Mask คอื ควรปรบัขนาดเครื่องมอื 

และคา Opacity ใหเหมาะสม

เมื่อตองทาํงานในบรเิวณที่มรีายละเอยีดมากๆ กค็วรลด

ขนาดหวัแปรงใหเลก็ลงโดยกดปมุ  หรอืกดปมุ  เมื่อ

ตองการขยายขนาดหวัแปรงใหใหญขึ้น

สวนคา Opacity นั้นควรลดใหตํ่าลงหากขอบเขตของภาพ

ไมชดัเจนซึ่งจะชวยเกลี่ยใหภาพมคีวามกลมกลนืกนั และควร

เพิ่มขึ้นหากตองการลบพื้นที่เหลานั้นออกไปจากภาพทั้งหมด

เหนือสิ่งอื่นใดคือความอดทนในการทํางาน ยิ่งเรามี

ความละเอยีดรอบคอบมากเทาใด กจ็ะยิ่งชวยใหภาพผลลพัธ

มคีวามสมบูรณสวยงาม

มเีทคนคิอยางหนึ่งที่นาสนใจคอื เครื่องมอื  (Brush 

Tool) จะมีหัวแปรงอยูหลายรูปแบบ ซึ่งเราสามารถเปลี่ยน

หวัแปรงไปเปนแบบตางๆ เพื่อใชงานรวมกบั Layer Mask ได 

เชน เมื่อทํางานกับทุงหญาก็สามารถเลือกหัวแปรงแบบ 

Grass เพื่อซอนหรอืแสดงขอบเขตใหทุงหญาได

ตัวอยางของหัวแปรงแบบตางๆ ที่สามารถนํามาใชรวมกับ Layer 
Mask ได
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ปรับปรุง Selection ดวย Refine Edge

เลือกรูปแบบแสดงภาพขณะใช
งานคําสั่ง

เลือกเครื่องมือในการทํางาน

ปรับเสนขอบใหนุมนวลขึ้น
ปรับเสนขอบใหฟุงขึ้น

ปรับเสนขอบใหคมชัดขึ้น
เพิ่มหรือลดระยะเสนขอบ

คลิกเครื่องหมายถูกพรอมปรับคา
เพื่อใหคําสั่งตรวจสอบเสนขอบ 
Selection ที่สมบูรณขึ้น

คลิกเครื่องหมายถูกพรอมปรับคา
เพื่อกระจายสีไปยังเสนขอบให
กลมกลืนกับฉากหลังมากขึ้น

เลือกรูปแบบภาพผลลัพธหลังจากปรับปรุง
ขอบเขต Selection เสร็จแลว

การนําภาพถ่ายมาตัดต่อร่วมกันแล้วให้ได้ผลลัพธ์ท่ี
สมจริง การปรับให้เส้นขอบของภาพเนียนเรียบ ไม่ขาดแหว่ง 
หรือมีสีของฉากหลังเดิมติดมาด้วย ถือว่าเป�นจุดเริ่มต้นที่ดี
ในการทํางาน เม่ือมีการปรับปรุงแสงเงา หรือใส่เอฟเฟ�กต์
เพิ่มเติมก็จะทําให้ภาพนั�นออกมาสมบูรณ์ขึ�นได้

ใน Photoshop มีคําสั่งหนึ่งที่เรียกว่า Refine Edge 
ซ่ึงเป�นคําสั่งที่จะช่วยให้เราสามารถปรับปรุง Selection ที่เรา
สรา้งไวใ้หส้มบูรณแ์บบ เมื่อตอ้งการใช�งานสามารถทาํไดโ้ดย
คลิกเมนู Select > Refine Edge หรือคลิกปุ่ม Refine Edge 
บนออปชันบาร์ โดยมีค่าการปรับแต่งที่สําคัญดังนีี� ตัวอยางการตัดตอภาพท่ีมีปญหาเนื่องจากสีของฉากหลังเดิมติดมาตาม

เสนขอบ รวมไปถงึภาพทีข่าดแหวงเน่ืองจากการสราง Selection ทีไ่มดนีกั
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สําหรับแนวทางการปรับปรุง Selection ด้วยคําสั่ง Refine Edge จะเริ่มต้นโดยการสร้าง Selection ไว้ก่อน หลังจาก
นั�นจึงใช�คําสั่ง Refine Edge เข้ามาช่วย ซ่ึงสามารถสรุปเป�นขั�นตอน ดังนี�

02 เมื่อหนาตางคาํสั่งปรากฏขึ้นมาใหเลอืกการแสดง

ภาพแบบ On Layer ซึ่งจะทาํใหเราเหน็ภาพที่เรา

กาํลงัทาํงานอยูบนฉากหลงัจรงิที่เราเตรยีมไว

03 เมื่อกดปมุ  + +  เพื่อซูมภาพเขาไปเราจะ

พบวาบรเิวณเสนขอบของภาพนั้นจะมสีเีดมิของ

ฉากหลงัตดิมาดวย ซึ่งจะตองแกไขใหเรยีบรอย

01 ใหนําภาพที่ตองการตัดตอมาวางซอนกันบนพาเนล Layers กอน หลังจากนั้นสราง Selection คลุมสวนที่จะ

นําไปใชงาน ซึ่งจากภาพตัวอยางผูเขียนใชวิธีสราง Selection ที่ทองฟากอนแลวจึงสลับ Selection โดยกดปุม

 +  + I  ไปที่ตวัมงักร เมื่อเรยีบรอยแลวคลกิปมุ Refine Edge บนออปชนับาร
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04 ใชเครื่องมือ  (Refine 

Radius Tool) แดรกเมาส

ไปบนเสนขอบที่มีสีของฉากหลังเดิม

ติดมา เมื่อปลอยเมาสเราก็จะเห็นวา

เสนขอบเหลานั้นถูกลบไปทนัที

ใชเครื่องมือ  (Refine Radius 

Tool) แดรกเมาสที่ขอบของภาพเพื่อ

ปรบัปรงุขอบ Selection จนทั่วทั้งภาพ 

ซึ่งขณะใชงานเครื่องมือนี้เราสามารถ

เพิ่ม หรือลดขนาดหัวแปรงไดโดย

กดปมุ  หรอื  

05 หลงัจากที่ใชเครื่องมอื  (Refine Radius Tool) แดรกเมาสที่ขอบของ

ภาพจนทั่วแลว ขั้นตอไปคอืการเกบ็รายละเอยีด โดยปรบัคาตางๆ ของ

คาํสั่ง เชน เพิ่มคา Smooth เพื่อใหขอบ Selection ไมเปนหยกัมากเกนิไป, ปรบัคา 

Feather เพื่อใหขอบฟุงเลก็นอย, ปรบัคา Contrast เพื่อใหขอบ Selection ชดัเจนขึ้น 

ลดคา Shift Edge ลงเลก็นอย เพื่อลดขอบสขีองภาพเกาที่ตดิมา เปนตน

06 คลิกเลือก Decontaminate Colors พรอมกับเพิ่มคา Amount ซึ่งจะ

เปนการกระจายสขีองภาพออกไปที่เสนขอบ เมื่อพอใจกบัผลลพัธแลว

ใหเลอืกรูปแบบผลลพัธในสวนของ Output To แลวคลกิปมุ OK

เมื่อปรบัปรงุ Selection ดวยคาํสั่ง Refine Edge เปนที่เรยีบรอยกจ็ะชวยใหการ

ทํางานในขั้นตอไปสะดวกขึ้น ภาพผลลัพธออกมาสมจริง สวยงามสมบูรณแบบ

ดงัตวัอยาง

เมื่อเพิ่มคา Amount ในสวน Decontaminate 
Colors แลวจะเห็นวาสีของภาพจะกระจาย
ไปบนเสนขอบดวย ทําใหผลลัพธออกมา
สมบูรณขึ้น
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จัดการกับเสนขอบภาพดวยคําสั่งในกลุม Matting

ปรับปรุงสีสันและแสงเงาของภาพ
ใน Photoshop จะมีคําสั่งสําหรับปรับปรุงสีสันและ

แสงเงาของภาพอยู่นับสิบคําสั่ง แต่มีสิ่งหนึ่งที่ต้องทําความ
เข้าใจคือ คาํสั่งเหลา่นี�สามารถเรยีกใช�งานไดจ้าก 2 วธีิ วธีิแรก
คือการเรียกใช�ผ่านเมนู Image > Adjustments โดยคําสั่ง
เหล่านี�จะเป�นการเข้าไปทํางานกับภาพโดยตรง หากมีความ
ผิดพลาดอาจแก้ไขได้ยาก แต่ก็มีข้อดีคือ โครงสร้างเลเยอร์
จะไม่ซับซ�อน สามารถทํางานอื่นๆ ต่อได้ทันที

การเรียกใชงานคําสั่งผานเมนู Image > 
Adjustmens จะเปนการใชคําสั่งทํางานกับ

ภาพโดยตรง

• Color Decontaminate ใชเกลี่ยสขีองภาพไปยงัเสนขอบ แตจะใชไดกบัภาพที่สราง Layer Mask เทานั้น

• Defringe ใชตดัสทีี่ตดิอยูบนเสนขอบออกไป โดยการระบคุวามหนาไดเอง

• Remove Black Matte ใชตดัขอบสดีาํที่ตดิมาบนภาพ

• Remove White Matte ใชตดัขอบสขีาวที่ตดิมาบนภาพ

จัดการกับ Selection ดวยคําสั่งในกลุม Modify
ในขณะที่เรากําลังทํางานกับ Selection อยู่เราสามารถปรับปรุง Selection นั�นใหม่ได้ 

ไม่ว่าจะเป�นการลดความหยักของ Selection หรือเพิ่มความฟุ้ง โดยใช�คําสั่งในกลุ่ม Modify 
ที่เรียกใช�ได้โดยคลิกเมนู Select > Modify ซ่ึงมีอยู่ 5 คําสั่ง ได้แก่

• Border ใชสาํหรบัสรางเสนขอบของ Selection

• Smooth ใชสาํหรบัลดความหยกัของเสน Selection

• Expand ใชสาํหรบัเพิ่มระยะของ Selection ออกไปดานนอก

• Contract ใชสาํหรบัลดระยะของ Selection ใหเขาดานในของวตัถทุี่เราสราง Selection ไว

• Feather ใชเพิ่มความฟุงให Selection มคีวามนุมนวลขึ้น

ในกรณีที่เรา Selection ภาพแล้วนําไปวางซ�อนบนฉากหลังใหม่แล้วพบว่า ยังมีสีของ
ภาพเดมิตดิมาดว้ย ถึงแมว้า่เราจะสรา้ง Selection ไดด้ขีนาดไหนกต็าม เราสามารถแก้ไขได้โดย
ใช�คําสั่งในกลุ่ม Matting ที่เรียกใช�ได้โดยคลิกเมนู Layer > Matting ซ่ึงมีอยู่ 4 คําสั่ง ได้แก่
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Essential Photoshop Skills
Intro

วิธีที่ สองของการปรับปรุง
สสีนั และแสงเงาของภาพคอืการเรยีก
ใช�คําสั่งผ่านพาเนล Adjustments 
ซ่ึงมีข้อดีกว่าตรงที่คําสั่งเหล่านี�จะ
ถูกสร้างเป�นเลเยอร์ใหม่ขึ�นมา ทําให้
สามารถปรับเปลี่ ยนค่าได้ตลอด
โดยไม่สร้างความเสียหายใดๆ ให้
แก่ภาพ

ขอ้ดอีกีอย่างของการเรียกใช�คาํสั่งผา่นพาเนล Adjusments คอื เราสามารถใช�เครื่องมอื  (Brush Tool) ระบายสดีาํ
หรือสีขาวลงไปใน Adjustment Layer เพื่อควบคุมขอบเขตของคําสั่งได้เช่นเดียวกับการทํางานกับ Layer Mask นั่นเอง

เมื่อคลิกปุมคําสั่งจากพาเนล Adjustments 
แลวจะปรากฏพาเนล Properties ขึ้นมา

เพื่อใชควบคุมคาของคําสั่ง
ที่เลือก และเมื่อสังเกตที่พาเนล Layers ก็
จะพบกับเลเยอรคําสั่งที่เราเลือกทํางาน 

ซึ่งสามารถลบทิ้ง หรือเปลี่ยนแปลงคาได
ตามความตองการ

ตัวอยางการทํางานโดยใชคําสั่ง Levels จากพาเนล Adjustments 
ปรับแสงของภาพใหมืดลง ซึ่งเราจะเห็นวาหลังจากใชคําสั่งจะปรากฏ 
Adjustment Layer บนพาเนล Layers ดวย

เมื่อใชเครื่องมือ  (Brush Tool) ระบายสีดําลงบน Adjustment 
Layer เราก็จะพบวาสามารถซอนขอบเขตของคําสั่ง Levels ได และ
หากตองการเพิ่มหรือลดความสวางก็สามารถทําไดอีกเชนกัน 
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Photoshop
Creative Retouch

คําสั่งสําหรับปรับสีสัน แสงเงาที่นาสนใจ
ในเรื่องของการรีทัชภาพ การปรับสีสัน และแสงเงาคือเรื่องที่สําคัญ เพราะนอกจากจะช่วยเพิ่มมิติให้ภาพแล้ว ยังช่วย

ควบคุมโทนอารมณ์ภาพ และสีสันของวัตถุแต่ละชิ�นที่ใส่ลงไปให้มีสีสันที่ใกล้เคียงกัน ซ่ึงใน Photoshop นั�นมีคําสั่งที่ทํางาน
ลักษณะนี�อยู่มากมาย แต่จะมีคําสั่งที่ใช�งานอยู่บ่อยๆ ดังนี�

ควบคุมความสวางดวย   Levels

Levels เป�นคําสั่งใช�แก้ไขความมืดหรือสว่างของภาพ ซ่ึงเราสามารถกําหนดจุดมืด-สว่าง รวมถึงความสว่างโดยรวม
ของภาพได้ เราสามารถเรียกใช�คําสั่งได้ เมื่อต้องการใช�งานคําสั่งนี�ทําได้โดยคลิกปุ่ม  บนพาเนล Adjustments หรือคลิก
เมนู Image > Adjustments > Levels ซ่ึงมีส่วนประกอบสําคัญ ดังนี�

เลือกปรับแตงแสง
แบบแยก Channel

ขาลากปรับแตง
แสง-เงา

คา Output Levels ที่ใชกําหนดความ
เขมของสีดําและสีขาวซึ่งจะใชงานคอน

ขางบอยในกระบวนการรีทัชภาพ

เครื่องมือกําหนดจุด
ที่มืด-สวางของภาพ

การปรบัแตงแสงเงาดวยคาํสั่ง Levels คอื ขาลากที่ใช

ควบคมุแสงเงามอียู 3 ตวัดวยกนั เมื่อมกีารปรบัแตงขาลาก

อนัใดอนัหนึ่ง แสงเงาของภาพกจ็ะเปลี่ยนไปดวย

Shadows 
ใชเพิ่มความ
เขมของเงา

Midtones ใช
เพิ่มความมืด

หรอืความสวาง
ใหโทนกลาง

ของภาพ

Highlights 
ใชเพิ่มความ

สวางใหไฮไลท

จากตัวอยางการทํางานนี้จะพบวา เราสามารถปรับแสงเงาขององคพระใหเขมขึ้นไดดวยคําสั่ง Levels โดยแดรกเมาสที่ขาลากของคําสั่งจนไดแสงเงาที่
ตองการ (ภาพขวา)

ภาพตนฉบับ
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